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Opis zadania  

Na początku roku 2017 na obszarze Górnego Śląska zaobserwowano sekwencję kilku wstrząsów 
sejsmicznych. Niniejszy warsztat ma na celu sprawdzenie czy w okresie 12 dni, od 08 marca 2017 r. 
do 20 marca 2017, zaobserwowano przemieszczenia na powierzchni terenu związane ze wstrząsami 
lub zwykłą działalnością górniczą. W tym celu użyte zostaną darmowe zobrazowania pochodzące 
z misji satelitarnej Sentinel-1 oraz różnicowa interferometria radarowa. Lokalizacje przemieszczeń 
zostaną również porównane z epicentrami wstrząsów sejsmicznych, które wystąpiły w analizowanym 
rejonie. 

Cel zadania 

• wyznaczenie wielkości przemieszczeń LOS (Line Of Sight – kierunek padania wiązki fali 
emitowane przez radar) dla obszaru górniczego zlokalizowanego na Górnym Śląsku, 

• porównanie obszarów występowania niecek obniżeniowych z lokalizacjami zarejestrowanych 
wstrząsów. 

Wykaz danych przestrzennych GIS 

• zobrazowania satelitarne satelity Sentinel-1 (Level-1 SLC) pozyskane w dniach:  
08.03.2017: 
S1A_IW_SLC__1SDV_20170308T050059_20170308T050126_015596_019A48_51A7.zip 
20.03.2017: 
S1A_IW_SLC__1SDV_20170320T050059_20170320T050127_015771_019F7E_6FF6.zip 
 

• plik zawierający epicentra wstrząsów górniczych na terenie Górnego Śląska): Wstrzasy.shp 

Wykaz stron internetowych 

• Pobieranie zobrazowań satelitarnych Sentinel-1:  
https://scihub.copernicus.eu/dhus/#/home 

• Informacje o występowaniu wstrząsów górniczych: 
https://tcs.ah-epos.eu/#episodes: 

Wykaz zastosowanego oprogramowania 

• SNAP 8.0 
• QGIS 3.16 
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Opis ćwiczenia  
1. Wczytanie zobrazowań satelitarnych do programu SNAP 

Interfejs programu składa się z kilku elementów, z których zasadniczą część stanowi okno wyświetlania 
danych (2) oraz okno, w którym wyświetlana jest lista zobrazowań wczytanych do projektu (1). 
W górnym pasku (3) widoczne są narzędzia z aktualnie włączonych pasków narzędziowych. 

 

W celu dodania zobrazowań satelitarnych do programu SNAP wybierz opcję File > Open Product, 
a następnie wskaż pliki w formacie katalogów ZIP, znajdujące się w folderze z zobrazowaniami 
satelitarnymi. 
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Lista wczytanych zobrazowań pojawia się w oknie Product Explorer. 

 
W sytuacji, gdy okno Product Explorer zostanie przypadkowo zamknięte, możne je ponownie otworzyć 
korzystając z opcji View > Tool Windows > Product Explorer. 

Każdy z zaimportowanych obrazów składa się z trzech pasów nazwanych kolejno: IW1, IW2 oraz IW3. 
Dane dla każdego z nich dostępne są zarówno dla polaryzacji VH, jak i VV. Ponadto rejestracja sygnału 
radarowego odbywa się w dwóch kanałach: synfazowym (I) i kwadraturowym (Q), które w kolejnych 
etapach mogą zostać przeliczone na amplitudę oraz fazę. Dla każdego z podanych pasów rejestracji 
(IW1-IW3) dostępne są zatem 3 pliki odpowiadające kolejno dwóm częściom sygnału radarowego 
(i_IW1_VV oraz q_IW1_VV), a także obrazy intensywności odbicia wiązki radarowej.  

Na potrzeby ćwiczenia można wyświetlić obraz Intensity_IW1_VV obejmujący obszar 
zainteresowania. 

Obraz intensywności odbicia wiązki fali radarowe dla pasa IW1. 

 
 

2. Ograniczenie zasięgu zobrazowań satelitarnych do obszaru opracowania 

Produkty SLC pozyskiwane w trybie Interferometric Wide (IW), rejestrują i zapisują dane 
w specyficznym formacie, dzieląc obraz SAR na 3 pasy pionowe (IW) i 9 poziomych (tzw. bursty). 
Z tego względu w ramach przygotowania danych niezbędne jest bardziej precyzyjne określenie 
obszaru zainteresowania. 

W głównym pasku narzędzi wybierz Radar > Sentinel-1 TOPS > S-1 TOPS Split.  W zakładce I/O 
Parameters definiujemy produkt wejściowy (Source Product) jako zobrazowanie, które 
zaimportowano w kroku 1, natomiast w Target Product określamy nazwę produktu wynikowego np. 
MD_3_3\Wyniki\Data1_split. W zakładce Processing Parameters należy doprecyzować obszar 
zainteresowania wskazując IW1, polaryzację pionową VV oraz zakres „burstów” ustawić za pomocą 
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suwaka na od 2 do 4. Po ustawieniu niezbędnych parametrów kliknij Run i analogiczne czynności 
przeprowadź dla drugiego obrazu. 

 
 
 
3. Uaktualnienie danych orbitalnych 

Do aktualizacji danych orbitalnych mających na celu poprawienie geometrii obrazów niezbędne jest 
podłączenie do sieci internetowej. Program automatycznie pobierze odpowiednie pliki do aktualizacji 
danych orbitalnych. Orbity precyzyjne, zapewniające najwyższą dokładność obliczeń, udostępniane są 
po ok. 20 dniach od daty wykonania zobrazowania. 

W głównym pasku narzędzi wybierz Radar > Apply Orbit File. W zakładce I/O Parameters w polu 
Source Product wskaż pierwsze z zobrazowań. Dla każdego kolejnego kroku nazwę pliku wynikowego 
pozostaw domyślną oraz wskaż format Save As: BEAM-DIMAP i miejsce zapisu na dysku 
(MD_3_3\Wyniki). W zakładce Processing Parameters w polu Orbit State Vector wskaż typ danych 
orbitalnych wybierając orbity precyzyjne: Sentinel Precise (Auto Download) oraz rekomendowany 
stopień wielomianu Polynomial Degree: 3.  Po ustawieniu parametrów procesu kliknij Run. 
Analogiczne czynności przeprowadź dla drugiego zobrazowania. 
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4. Współrejestracja zobrazowań 

Kluczowym elementem w procesie interferometrycznym jest dokładne dopasowanie geometryczne 
obrazów tzw. współrejestracja. Jest ona wykonywana w oparciu o dane orbitalne oraz numeryczny 
modelu terenu. Warto zwrócić uwagę, aby współrejestrowane dane posiadały ten sam numer ścieżki, 
w której zostały zarejestrowane (Track). Zobrazowania pozyskane w możliwie podobne geometrii 
pozwolą na poprawne obliczenie przemieszczeń w kierunku badania wiązki radarowej. 

W celu wykonania współrejestracji wybierz Radar > Coregistration > S1 TOPS Coregistration > S-1 
Back Geocoding. W zakładce ProductSet-Reader należy za pomocą znaku plusa dodać oba 
zobrazowania z końcówką _split_Orb. Obraz odpowiadający dacie wcześniejsze powinien znaleźć się 
u góry, ponieważ posłuży za obraz referencyjne (tzw. master). Kolejne zobrazowanie (tzw. slave) będzie 
wpasowywane w geometrię wcześniejszych danych. 

 
W zakładce Back-Geocoding należy wybrać NMT, na którego podstawie dane będą wpasowywane 
w siebie. Należy wskazać SRTM 1Sec, którego pobranie nastąpi w sposób automatyczny. Określ 
metodę przepróbkowania NMT DEM Resampling Method: Bicubic_Interpolation, metodę 
przepróbkowania obrazów Resampling Type: Bisinc_5_Point_Interpolation. Pozostałe parametry 
zostawić domyślnie. W ostatnie karcie Write należy wybrać lokalizację oraz nazwę pliku wynikowego 
(MD_3_3\Wyniki\Date1_Date2_Stack). 

mailto:michal.pilecki@polsa.gov.pl
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5. Generowanie interferogramu oraz estymacja koherencji 

Celem tego kroku jest wygenerowanie interferogramu pomiędzy dwoma zobrazowaniami czyli obrazu 
ukazującego różnicę fazy pomiędzy obrazami master i slave zapisane w zakresie – π do π. Dodatkowo 
wygenerowany zostanie obraz koherencji czyli współczynnika określającego spójność sygnały 
pomiędzy kolejnymi zobrazowaniami. Wartości bliskie 1 oznaczają dużą spójność sygnału i uznawane 
są za dane najbardziej wiarygodne. Koherencja wynosząca 0 oznacza brak spójności obrazów, a co za 
tym idzie, dalsze analizy mogą dostarczać mniej wiarygodnych wyników. 

W celu wygenerowania interferogramu i obrazu koherencji wybierz Radar > Interferometric  
> Products > Interferogram. 

W zakładce I/O Parameters jako Source Products wybierz plik z końcówką Stack oraz wskaż nazwę 
pliku wynikowego i miejsce jego zapisu. W oknie Processing Parameters: 

• zaznacz opcję Subtract flat-earth phase, usuwającą z interferogramu komponent fazy 
związany z tzw. "płaską Ziemią” i pozostaw parametry domyślnie, 

• zaznacz opcję generowania obrazu koherencji Include coherence estimation, 
• pozostaw zaznaczoną opcję Square Pixel. 

 

mailto:michal.pilecki@polsa.gov.pl
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W celu sprawdzenia poprawności wyników wyświetl obraz fazy, intensywności i koherencji. W celu 
porównania danych można ustawić wyświetlanie jako Tile Vetically w górnym pasku menu: 

 

Obraz fazy, intensywności oraz koherencji dla wybranego obszaru. 

 
 

6. Łącznie pasów zobrazowania w jeden spójny obraz 

Z uwagi na charakterystykę pozyskiwania produktów SLC i wynikający z tego podział obrazu na tzw. 
bursty, przetwarzane obrazy należy scalić w jeden spójny obraz. 
 
W menu wybierz Radar > Sentinel-1 TOPS > S-1 TOPS Deburst. W oknie I/O Parameters jako 
produkt wejściowy wskaż wygenerowany interferogram z końcówką _ifg. W zakładce Processing 
Parameters należy wybrać polaryzację, dla której będzie scalany obraz. W przypadku przetwarzanych 
danych dostępna jest wyłącznie polaryzacja pionowa VV, którą wybrano na etapie funkcji Split. 
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Interferogram po złączeniu burstów. 

 
 
 

7. Usunięcie składowej odpowiadającej za rzeźbę terenu – generowanie interferogramu 
różnicowego 

Usuwanie z interferogramu komponentu topograficznego, związanego z ukształtowaniem terenu, jest 
przeprowadzane z wykorzystaniem NMT. Etap ten jest kluczowy w aplikacji interferometrii różnicowej, 
ponieważ pozostała różnica fazy odpowiada wyłącznie przemieszczeniom i ewentualnym szumom. 

W celu wykonania tego procesu wybierz Radar > Interferometric > Products > Topographic Phase 
Removal. W zakładce parametrów wskaż numeryczny model terenu Digital Elevation Model: SRTM 
1 Sec HGT.  

 

W celu sprawdzenia wpływu topografi terenu należy wyświetlić rastry Phase dla produktów 
z końcówką _deb i _dinsar. 
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Interferogram zawierający wpływ topografii terenu (górna część) oraz po jej usunięciu (dolna część). 

 
 
8. Filtracja interferogramu 

Wygenerowany interferogram zawiera znaczną ilość szumów. W celu zidentyfikowania obszarów 
ulegających przemieszczeniu obraz należy poddać filtracji. 
 
W tym poprawienia jakości interferogramy poprzez filtrowanie wybierz Radar > Interferometric > 
Filtering > Goldstein Phase Filtering. W zakładce parametrów określ wielkość okna filtracji Window 
Size: 3 Adaptive Filter Exponent in (0,1): 0.4, FFT Size: 64. Na tym etapie w zależności od danych 
należy przeprowadzić testy parametrów filtracji, aby określić, w które konfiguracji otrzymamy najlepsze 
rezultaty. Dodatkowo na tym etapie można przeprowadzić filtrację z użyciem maski koherencji. Na 
potrzeby ćwiczenia zostaw okno Use coherence mask odznaczone. 

 

mailto:michal.pilecki@polsa.gov.pl


                                                                                               

12 

Siedziba główna Agencji |ul. Trzy Lipy 3 (Budynek C), 80-172 Gdańsk | tel. +48 58 500 87 60 | e-mail: sekretariat@polsa.gov.pl 
Oddział w Warszawie | ul. Prosta 70, 00-838 Warszawa | tel. +48 22 380 15 50 | e-mail: sekretariat.warszawa@polsa.gov.pl 
Oddział w Rzeszowie | ul. Warszawska 18, 35-205 Rzeszów | tel. +48 516 222 695 | e-mail: michal.pilecki@polsa.gov.pl 
 

 
 

Poniżej przedstawiono interferogram po filtracji. Z uwagi na to, że analizowany obszar jest bardzo duży, 
w celu zidentyfikowania obszarów, gdzie nastąpiły przemieszczenia należy przybliżyć obraz 
i przeszukać go w poszukiwaniu gęstszych prążków interferometrycznych. 

 
Jeden z obszarów, gdzie odnaleziono niecki obniżeniowe przedstawiono poniżej.  

Położenie zlokalizowanego obszaru na tle całego interferogramu: 

 
Zbliżenie 1: prążki interferometryczne sygnalizujące obszary ulegające przemieszczeniu. 

 
 

 

 

 

mailto:michal.pilecki@polsa.gov.pl


                                                                                               

13 

Siedziba główna Agencji |ul. Trzy Lipy 3 (Budynek C), 80-172 Gdańsk | tel. +48 58 500 87 60 | e-mail: sekretariat@polsa.gov.pl 
Oddział w Warszawie | ul. Prosta 70, 00-838 Warszawa | tel. +48 22 380 15 50 | e-mail: sekretariat.warszawa@polsa.gov.pl 
Oddział w Rzeszowie | ul. Warszawska 18, 35-205 Rzeszów | tel. +48 516 222 695 | e-mail: michal.pilecki@polsa.gov.pl 
 

 
 

9. Przycięcie interferogramu do obszaru zainteresowania 

Z uwagi na spory zakres przestrzenny utworzonego interferogramu, do dalszych obliczeń należy 
zawęzić obszar zainteresowania. Poniżej przedstawione orientacyjną lokalizację przycięcia obszaru 
oraz fragment interferogramu, na którym będziemy pracować dalej. Należy odszukać go na 
interferogramie, bądź wybrać inny obszar, gdzie widoczne są prążki interferometryczne. 

Orientacyjna lokalizacja obszaru na tle interferogramu. 

 
Fragment wybrany do dalszych analiz, zawierający kilka niecek obniżeniowych 

 
 
Po zlokalizowaniu na interferogramie interesującego nas rejonu należy w oknie wyświetlania 
pozostawić widoczny tylko obszar wybrany do dalsze analizy (jak na obrazie wyżej). Po ustawieniu 
wyświetlania w ten sposób należy kliknąć w obraz prawym przyciskiem myszy i wybrać opcję Spatial 
Subset from View. W pierwsze zakładce wyświetla się orientacyjny zasięg przestrzenny przycięcia, 
którego nie należy modyfikować.  W zakładce Band Subset można określić warstwy, które zostaną 
zapisane. Należy zostawić wszystkie warstwy zaznaczone. 
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Po kliknięciu OK, po lewe stronie w oknie Products Explorer pojawi się nowy produkt o początku 
subset. Należy go zapisać klikając prawy przycisk myszy i wybrać opcję Save As. 
 
 
10. Rozwinięcie fazy interferogramu 

Wyznaczona różnica fazy odpowiadająca przemieszczeniu terenu ukazana jest w formie cyklicznych 
prążków interferometrycznych, który wartości mieszczą się w zakresie od – π do π. Aby uzyskać 
informację o pełnej ilości cykli, a tym samym całkowitej wartości przemieszczeń niezbędne jest 
rozwinięcie fazy, podczas którego wyliczana jest liczba odłożeń pełnej długości fali wiązki radarowej. 
 

10.1.  Eksport danych do rozwinięcia. 
W tym celu przefiltrowane i przycięte dane należy wyeksportować za pomocą Radar > 
Interferometric > Unwrapping > Snaphu Export.  

W zakładce parametrów Snaphu-Export wskaż folder docelowy dla plików Snaphu Wyniki\EXP 
oraz ustaw pozostałe parametry następująco: Statisical-cost Mode: DEFO, liczbę kafelków, na 
które zostanie podzielony obraz Number of Tile Rows: 10, Number of Tile Columns: 10, Row 
i Column Overlap: 200. W przypadku, gdy rozwinięcie zostanie wykonane nieprawidłowo, należy 
zmodyfikować parametry eksportu. 

 
 

10.2.  Rozwinięcie fazy interferogramu za pomocą wtyczki Unwrapping. 
W celu rozwinięcia fazy w programie SNAP należy upewnić się, że zainstalowana jest wtyczka 
SNAPHU Uwrapping. Zainstalowane wtyczki można sprawdzić wybierając w menu Tools > 
Plugins. 
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Po zainstalowaniu wtyczki rozwinięcia fazy można dokonać wybierając: Radar > Interferometric > 
Unwrapping > Snaphu-unwrapping. W pierwszej z zakładek jako Source Product wskazujemy 
plik po filtracji (_flt) oraz przycięciu (subset). W Processing Parametrs zaznaczmy opcję Display 
execution output, dzięki czemu będziemy mogli podejrzeć czy proces rozwijania fazy działa, a jako 
Output folder wskazujmy miejsce, do którego dokonaliśmy Exportu we wcześniejszym kroku. 
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10.3.  Import rozwiniętej fazy. 
Rozwiniętą fazę należy ponownie zaimportować do pogramu za pomocą Radar > Interferometric 
> Unwrapping > Snaphu Import 
 
W oknie 1-Read-Phase ponownie wskazujemy plik ze SNAP zawierający przefiltrowane dane, 
które docięto do obszaru zainteresowania. 

 
W oknie 2-Read-Unwrapped-Phase za pomocą symbolu … należy odnaleźć lokalizację folderu do 
której dokonaliśmy eksportu danych. W tym folderze szukamy pliku zaczynającego się od 
UnwPhase_ oraz z rozszerzeniem .hdr. 
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W oknie 3-SnaphuImport odznaczamy opcję Do NOT save Wrapped interferogram in the target 
product. 

 
W 4 zakładce wpisujemy nazwę pliku wynikowego z dopiskiem _unw. 
Dla porównania z nowoutworzonego pliku należy wyświetlić warstwy Phase i Unw_Phase. 
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11. Przeliczenie rozwiniętych wartości fazy na przemieszczenia 

Informacje w utworzonych plikach zwierając informacje dotyczą wyłącznie zmiany fazy sygnały 
radarowego. W celu przeliczenia tych wartości na metryczne wartości przemieszczeń w kierunku 
obrazowania satelity (Line Of Sight) należy dokonać dodatkowych obliczeń. 
 
W celu pozyskania informacji o wartości przemieszczeń LOS w metrach należy wybrać Radar > 
Interferometric > Products > Phase to Displacement. Dla tej funkcji nie jest potrzebne określanie 
żadnych dodatkowych parametrów. Wartości przemieszczeń wyrażone w metrach zostaną zapisane 
w pliku z końcówkę _dsp. 
 
Z uwagi na niewielkie przemieszenia w analizowanym 12-dniowym okresie, w celu bardziej czytelnej 
wizualizacji wartości można przeliczyć na mm wykorzystując Band Maths. W tym celu w Products 
Explorer należy rozwinąć produkt zawierający wartości przemieszczeń i pod prawym kliknięciem 
myszy wybrać opcję Band Maths. Zaznaczenie opcji Virtual pozwoli na utworzenie nowego rastra, ale 
bez zapisania nowych wartości przemieszczeń. W Band maths expression należy wpisać 

displacement*1000 

 
 
12. Określenie poziomu odniesienia 

Wyznaczone w poprzednich krokach wartości przemieszczeń nie są jednak ostatecznymi wielkościami, 
które powinny podlegać analizie. W celu poprawnej interpretacji wartości należy określić dodatkowo 
poziom odniesienia, którym jest teren uznawany za stabilny. W tym celu należy określić średnią 
wartość wyznaczoną dla obszaru poza nieckami. W przypadku prezentowanych danych będą to 
wartości zaznaczone kolorem niebieskim na interferogramie.  
 
Istnieje klika sposobów na określenie poziomu odniesienia, m.in. za pomocą wyliczenia statystyk dla 
danego rastra. Wybierz Analysis > Statistics. Kursorem wskaż warstwę z przemieszczeniami 
wyrażonymi w mm (Dsp_mm) i kliknij ikonę odświeżania okna. 
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Wyświetlona zostaną statystyki, z których wybieramy wartość średnią Mean i zapamiętujemy.    

 
Następnie przy użyciu Band Maths warstwę Dsp_mm odpowiednia powiększamy lub pomniejszamy 
o wartości Mean tak, aby obszar poza nieckami wynosił +/- 0 mm. 

 
 

Obliczone w ten sposób wartości mogą być brane do dalszych analiz. Wyświetl nowopowstałą 
warstwę, aby sprawdzić ostateczne wartości przemieszczeń. W zakładce Color Manipulation kliknij 
ikonę folderu i ustaw styl wyświetlania na cubehelix_cycle.cpd. 
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Otrzymane wartości przemieszczeń przedstawiono poniżej. Czerwone prostokąty wskazują 
przykładowe obszary zawierające błędne wartości co spowodowane jest słabą jakością sygnału i niską 
koherencją w tych rejonach. 
 

 
 
13. Nałożenie maski koherencji 

W celu wykluczenia z analiz obszarów o słabej koherencji, czyli dostarczających informacji o mniejszej 
wiarygodności należy na wyniki nanieść maskę koherencji. Pozwoli to na wyrzucenie z analiz wyników 
słabe jakości oraz części szumów.  

 
Z głównego menu wybierz Raster > Band Maths. W oknie Band Maths wybierz produkt, w którym 
zostanie stworzony nowy obraz Target Product, czyli plik z końcówką _dsp. Określ nazwę tworzonego 
obrazu Name Dsp_mm_Ref_CohMask_0.4. Dodatkowo odznacz opcję tworzenia pliku wirtualnego, 
niezapisywanego na dysku Virtual. Następnie kliknij na przycisk Edit Expression w celu zastosowania 
wartości progowej/określenia formuły. Nasze wyrażenie zawierające maskę koherencji przemnożymy 
od razu przez wartości przemieszczeń z uwzględnionym poziomem odniesienia. Z tego powodu 
w SNAPie muszą pozostać 2 pliki zawierające rozwiniętą fazę i przemieszczenia. Nową warstwę 
dodajemy do pliku z przemieszczeniami, natomiast informacje o wartości koherencji zawiera tylko plik 
z rozwiniętą fazą. W polu Expression wpisz formułę: 

.Dsp_mm_Reference * (if coh_IW1_VV_08Mar2017_20Mar2017 then NaN else 1) 

Jeżeli program nie znajdzie błędu zostanie wyświetlony komunikat: Ok, no errors. Po czym kliknij OK 
i następnie też OK. 
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Przemieszczenia po naniesieniu maski koherencji: 

 
 
14. Nadanie georeferecji 

W celu konwersji obrazów z układu radarowego do układu współrzędnych należy wybrać Radar > 
Geometric > Terrain Correction > Range-Doppler Terrain-Correction. 

W zakładce parametrów wskaż obraz Dsp_mm_Reference i Dsp_mm_Ref_CohMask_0.4. W polu 
numerycznego modelu terenu Digital Elevation Model wskaż: SRTM 1Sec HGT (Auto Download). 
Jako metodę przepróbkowania DEM DEM resampling method wybierz: Bicubic Interpolation, a jak 
w przypadku metody przepróbkowania obrazów transformowanych Image Resampling Method: 
BISNIC_5_POINT_INTEPROLATION. W zakładce Map Projection można zdefiniować układ 
współrzędnych, do którego chcemy przetransformować rastry. Domyślnie jest to układ WGS84. 
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Przemieszczenia po georefrencji z maską koherencji równą 0.4 (lewa strona) i bez maski (prawa strona): 
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15. Eksport danych do systemów GIS wraz z wizualizacją 

Przygotowane rastry z przemieszczeniami wyeksportuj do formatu GeoTIFF, aby wyświetlić je 
w programie QGIS. Wybierz File > Export > GeoTIFF / Big Tiff. W oknie eksportu wybierz Subset, aby 
wybrać konkretną warstwę, która ma zostać zapisana do formatu GeotTIFF. Wybór odpowiedniej 
warstwy dokonuje się w zakładce Band Subset. Osobno wyeksportuj dane z maską koherencji i bez niej. 

 
W następnym kroku należy przejść do programu QGIS i do nowego projektu przeciągnąć 2 
wygenerowanie GeoTIFFy oraz plik shapefile ze współrzędnymi wstrząsów (Wstrzasy.shp). 

W panelu Warstwy przejdź do Właściwości warstwy i w zakładce Styl wczytaj przygotowane style 
wyświetlania dla każdej z warstw: 

• dsp.qml dla rastra z przemieszczeniami bez maski koherencji, 

• dsp_masked.qml dla rastra z przemieszczaniami z maską, 

• wstrząsy_styl.qml dla pliku shapefile z wstrząsami górniczymi. 

 

Do wyświetlonych wyników można podłączyć podkłady mapowe przez XYZ Tiles > Nowe połączenie, 
takiej jak: 

• Google Maps, URL: http://mt0.google.com/vt/lyrs=s&hl=en&x={x}&y={y}&z={z} 

• OpenStreetMap, URL: https://tile.openstreetmap.org/{z}/{x}/{y}.png 

 

Poniżej przedstawiono przykładową wizualizację dla przemieszczeń LOS z maską koherencji oraz bez 
maski. Plik ze wstrząsami górniczymi zawiera dane dla większego obszaru. Warto jednak zwrócić 
uwagę, że na etapie przetwarzania danych radarowych znacząco ograniczyliśmy obszar opracowania 
do tylko kilku niecek obniżeniowych. Przy wybraniu większego obszaru, analiza mogłaby objąć 
zasięgiem również pozostałe wstrząsy. Część niecek widoczna na danych DInSAR wprost wynika 
z wstrząsów sejsmicznych, natomiast pozostałe obniżenia mogą być spowodowane innymi czynnikami, 
które należałoby dodatkowo przeanalizować. Wyniki zawierające maskę koherencji wskazują, że 
najniższe wartości uzyskano dla obszarów pokrytych lasem i dzięki temu wyłączono z analizy zbędne 
szumy. Przy założeniu wartości granicznej koherencji równej 0.4 wykluczyliśmy natomiast z analizy 
również części niecek, które zawierały wartości przemieszczeń, stąd poprawne wyznaczanie wartości 
granicznej koherencji ma znaczący wpływ na nasze analizy. Każda z analizowanych niecek na 
przestrzeni 12 dni poddanych analizie ukazała przemieszczenia na poziomie kliku cm, co biorąc pod 
uwagę stabilność terenu poza nieckami stanowi wiarygodne wielkości. W celu wyznaczenia 
przemieszczeń pionowych niezbędne jest wykonanie analogicznych obliczeń dla zobrazowań 
pochodzących z drugiej orbity. 
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